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3.1 Models based on the Reisby data 

3.1.1 The data 

The data set is from a study described in Reisby et. al. (1977) that focused on the lon-
gitudinal relationship between imipramine (IMI) and desipramine (DMI) plasma levels and 
clinical response in 66 depressed inpatients (37 endogenous and 29 non-endogenous). 
Following a placebo period of 1 week, patients received 225 mg/day doses of imipramine for 
four weeks. In this study, subjects were rated with the Hamilton depression rating scale 
(HDRS) twice during the baseline placebo week (at the start and end of this week) as well as 
at the end of each of the four treatment weeks of the study. Plasma level measurements of 
both IMI and its metabolite DMI were made at the end of each week. The sex and age of each 
patient were recorded and a diagnosis of endogenous or non-endogenous depression was 
made for each patient.  
 
Although the total number of subjects in this study was 66, the number of subjects with all 
measures at each of the weeks fluctuated: 61 at week 0 (start of placebo week), 63 at week 1 
(end of placebo week), 65 at week 2 (end of first drug treatment week), 65 at week 3 (end of 
second drug treatment week), 63 at week 4 (end of third drug treatment week), and 58 at 
week 5 (end of fourth drug treatment week). The sample size is 375. Data for the first 10 
observations of all the variables used in this section are shown below in the form of a 
SuperMix spreadsheet file, named reisby.ss3. 



 

 
 
The variables of interest are: 
 

o Patient is the patient ID (66 patients in total). 
o HDRS is the Hamilton depression rating scale. 
o WEEK represents the week (0, 1, 2, 3, 4 or 5) at which a measurement was made. 
o WEEKSQ represents the squared values of WEEK.  
o ENDOG is a dummy variable for the type of depression a patient was diagnosed with 

(1 for endogenous depression and 0 for non-endogenous depression). 
o WxENDOG represents the interaction between WEEK and ENDOG, and is the product 

of WEEK and ENDOG. 
 

3.1.1.1 Exploring the data 

Graphing the observed data 

In the previous example, we have shown a number of data-based graphs. Here, we use the 
Exploratory option of the Data-Based Graphs menu to explore the data in the reisby.ss3 
spreadsheet, stored in the Continuous subfolder.  
 
Start by opening the data file in the SuperMix spreadsheet. Then select the Data-based Graphs, 
Exploratory option on the File menu as shown below to activate the New Graph dialog box. 
 
Specify HDRS as the dependent (vertical axis) variable by selecting it from the Y drop-down 
list box and WEEK as the independent (horizontal axis) variable by selecting it from the X 
drop-down list box. A graph on the same axis system is created for each patient by selecting 
the variable Patient from the Overlay drop-down list box. Furthermore, each graph is assigned 
a color by selecting ENDOG from the Color drop-down list box to produce the following New 
Graph dialog box.  
 
 



 
 

  
 

Click on the OK button to produce the following graph of the reaction trajectories over time 
for the 66 inpatients. 
 

 
Figure 3.4: Reaction trajectories over time for 66 patients 

 
To modify the existing graphic display, select the Edit Graph option from the Settings menu 
to load the Edit Graph dialog box. To obtain different graphs for the two categories of the 



covariate ENDOG, select it from the Filter drop-down list box to produce the following Edit 
Graph dialog box. 

 

 
 

Click on the OK button to open the following graphics window. 
 

 
Figure 3.5: Reaction trajectories over time for patients with ENDOG=0 

 
At the bottom of the graphics window is a "slider" with left and right arrows. By clicking on 
the right arrow, one can obtain the next graphic shown below and by clicking on the left 
arrow, the graphic above. 
 



 
Figure 3.6: Reaction trajectories over time for patients with ENDOG=1 

 
The above graphs show a general, approximately linear decline over time and an increase in 
the variability of the HDRS scores across time for both types of depression.  
 

3.1.2  A 2-level random intercept-and-slope model 

From the graphical display obtained in the previous section, it seems as if the HDRS scores 
follow an approximately linear trend over time, decreasing over the course of the study. It is 
also apparent, however, that patients not only start out at different levels but also have 
differences in the slopes of the HDRS against WEEK lines. In this section, we explore a model 
that allows patients not only to have unique intercepts, but also unique slopes across time. In 
other words, we allow both intercept and WEEK (slope) to vary randomly over patients. The 
image below demonstrates the meaning of the random slope and random intercept in a 
hypothetical 2-level model.  
 

 

Figure 3.7: Score trends for individual patients 
 

3.1.2.1 The model 

The random intercept-and-slope model for the response variable HDRS may be expressed as 

 ( ) ( )0 1 0 1HDRS WEEK WEEKij i i ijij ij
v v eβ β= + × + + +  

Trend of patient 1 

Average trend of all patients 

Trend of patient 2 



We can rewrite the model in the following way.  
 
Level-1 model:  
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0β  denotes the average expected depression rating scale value, 1β  denotes the coefficient of 
the predictor variable WEEK (slope) in the fixed part of the model, 1iv  denotes the variation in 
the slopes over patients, and 0iv  and ije  denote the variation in the average expected HDRS 
value over patients and between patients respectively. Furthermore, i = 1,2,…,66 refers to the 
66 patients; j = 1, 2, …, in  refers to the thj  observation for patient i. The maximum value for 

in  is 6. 

 

3.1.2.2 Setting up the analysis 

Start by opening the reisby.ss3 file as a SuperMix spreadsheet. Next, select the New Model 
Setup option on the File menu as shown below to load the Model Setup window.  
 

 
 



Starting with the Configuration screen, enter the (optional) title in the Title 1 and Title 2 text 
boxes respectively. The continuous outcome variable HDRS is selected from the Dependent 
Variable drop-down list box. The variable Patient, which defines the levels of the hierarchy, is 
selected as the Level-2 ID from the Level-2 IDs drop-down list box to produce the following 
Configuration screen.  
 

 
 
Click the Variables tab to proceed to the Variables screen of the Model Setup window. The 
variable Week is specified as the covariate of the fixed part of the model by checking the E 
check box for WEEK in the Available grid. Mark the 2 check box for Week in the Available 
grid to specify the random slope at level 2 of the model. After completion, the Variables 
screen should look as shown below. 
  



 
 
Before the analysis can be run, save the model specifications to reisby1.mum. Run the model 
to produce the output file reisby1.out.  
 

3.1.2.3 Discussion of results 

Descriptive statistics 

The section of the output file shown below contains the descriptive statistics for all variables 
in the current model specification. If all patients' data were complete, the average for the time 
variable WEEK would have been exactly 2.5; the value of 2.48 indicates that the number of 
patients with information at each time point fluctuates somewhat. 
 

 



3.1.2.4 Interpreting the results 

 
 

The summary of the hierarchical structure of the data shows how the 375 measurements are 
nested within the 66 patients. It also indicates that the number of repeated measurements per 
patient varies from 4 to 6 observations. The convergence is attained in 5 iterations. The 
output file contains the final estimates of the fixed and random coefficients included in the 
model, along with some goodness of fit measures as shown . 

 

 
 

Fixed effects results 

The results show a highly significant coefficient (p < 0.00001) for the time effect, as 
represented by the variable WEEK. At the beginning of the study, when WEEK = 0, the 
average expected HDRS score is 23.57695. For each subsequent week, a decrease of 2.37707 
in average HDRS score is expected. At the end of the study period, the average expected 
HDRS score is 23.57695 – 5(2.37707) = 11.6916. 
 



Random effects results 

With the exception of the WEEK-intcept covariance, all variance components are highly 

significant, as shown in the p-value column. From the output above we have 0var( )iv
∧

 = 

12.62930, 1var( )iv
∧

 = 2.07899, 0 1cov( , )i iv v
∧

 = –1.42093, and var( )ije
∧

 = 12.21663. Typically, 
one would expect most of the variation in HDRS scores at the measurement level, and thus 

would expect var( )ije
∧

 to be larger than any of the other variances/covariances. With these 
data, however, there is more variation in the random intercepts over patients than in the 
measurements nested within patients. Due to this, it may be of interest to take a closer look at 
the variation in HDRS scores at the two levels of the hierarchy. 
 

Fit statistics and ICC 

In the case of a model with only a random intercept, there are two variances of interest: the 
variation in the random intercept over the patients (the level-2 units), and the residual 
variation at level 1, over the measurements. By calculating the total variation in the HDRS 

score explained by such a model, obtained as 0var( ) var( )ij ie v
∧ ∧

+ , we can obtain an estimate of 
the intracluster correlation coefficient. 
 
The intracluster coefficient is defined as 
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and would, for a random intercept model for this data, represent the proportion of variation in 
HDRS scores between patients. The term intracluster correlation coefficient applies to random 
intercept models only; in more complicated models the focus is on explanation of variation in 
various coefficients. 
 
In the current model, the situation is somewhat more complicated due to the inclusion of both 
random intercept and random slope. This implies a possible correlation between the level-2 
random effects. When calculating an estimate of the total variation, the covariance(s) 
between random effects have to be taken into account in any attempt to estimate the 
proportion of variation in outcome at any level or for any random coefficient. In addition, the 
inclusion of a covariate such as ENDOG can affect the variance estimates.  
 
The total variation in HDRS scores over patients is defined as 

 [ ]2
0 1 0 1Var(level 2) var( ) var( )(WEEK) 2 cov( , ) (WEEK)i i ij i i ijv v v v= + +  



The total variation is a function of the value assumed by the predictor WEEK, which has a 
random slope. As such, the total variation at the beginning of the study is 

 [ ]2
0 1 0 1
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while at the end of the study we have 

 [ ]2
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0 1 0 1

Var(level 2) var( ) var( )(5) 2 cov( , ) (5)
var( ) 25var( ) 10cov( , )

i i i i
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An estimate of the total variation at this level can be obtained by using the estimates of the 

variances and covariance obtained under this model. By substituting 0var( )iv
∧

, 1var( )iv
∧

, and 

0 1cov( , )i iv v
∧

 into the equations above, we obtain the estimated variation in HDRS scores over 
patients at different points during the study period. 
 
At the beginning of the study, the estimated total variation in HDRS scores over patients is 

simply the estimated variation in the random intercept, i.e., 0var( )iv
∧

 = 12.62930. At the end 
of the study, the total variation at level-2 is estimated as 

0 1 0 1var( 2) var( ) 25var( ) 10cov( , )
12.62930 25(2.07899) 10( 1.42093)
50.39475.

i i i ilevel v v v v
∧ ∧ ∧ ∧

= + +
= + + −
=

 

At the beginning of the study we obtain  

 
var(level 2) 12.62930

12.62930 12.21663var(level 2) var(level1)
0.5083

∧

∧ ∧ =
++

=

 

and thus conclude that 50.8% of the variation in HDRS scores at this time is over patients. At 
the end of the study, we find that  

var(level 2) 50.39475
50.39475 12.21663var(level 2) var(level1)
0.8049,

∧

∧ ∧ =
++

=

 

so that only 20% of the variation in HDRS scores are estimated to be at the measurement 
level, with 80% at the patient level. As mentioned before, the total variation in HDRS scores 
is a function of the time of measurement, as represented by the variable WEEK. The very 
different estimates of variation at a patient level show how the introduction of an important 



predictor, in this case at the measurement level, can have an impact on variance estimates at a 
different level of the hierarchy. By the end of the study period, the residual variation over 
measurements has been dramatically reduced, this being explained to a large extent by the 
inclusion of the time effect. Most of the remaining unexplained variation is at the patient 
level.  
 
As a result of this finding and in the light of our original research question, whether the initial 
depression classification of a patient is also related to the HDRS scores over the time in which 
medication is administered, the model will be extended to include the covariate ENDOG. This 
dichotomous variable assumes a value of 1 when endogenous depression was diagnosed, and 
0 if not. In addition, we will provide for a possible interaction between depression 
classification and measurement occasion by including the interaction term WxENDOG in the 
model. While WxENDOG can be viewed as a cross-level interaction, as WEEK is a 
measurement-level variable and ENDOG a patient-level variable, the inclusion of the patient-
level variable ENDOG may enable us to explain more of the remaining variation in the 
random intercepts and slopes at the patient level. 
 

3.1.3 A 2-level random intercept-and-slope model with centered predictor 

In the previous example, the time variable WEEK is coded from 0 to 5 and indicates the 
number of weekly follow-ups. The estimated average intercept of 23.577 obtained for this 
model represented the expected average HDRS score at the beginning of the study, i.e. WEEK 
= 0. An alternative formulation of the model that can be considered is one in which the 
estimated average intercept represents the expected average HDRS score midway through the 
study period. This linear transformation of the predictor variable WEEK, in which the grand 
mean of the variable is subtracted from each observed WEEK value, is referred to as grand 
mean centering. While the model based on the "raw" data and the model utilizing grand mean 
centered variables can be shown to be mathematically equivalent, the coefficients in these 
models have very different meanings.  
 

3.1.3.1 Preparing the data 

Recall that the descriptive statistics in the previous model indicated a mean value over all 
level-1 observations of WEEK equal to 2.48. This is the true observed mean, compared to the 
value of 2.5 that would have been obtained if all patients had complete data over the course 
of the study. Here, we opt to use the value of 2.5 to center the WEEK variable.  
 
To grand mean center the predictor WEEK, proceed as follows. Open the reisby.ss3 in the 
SuperMix spreadsheet, then highlight the column WEEK. Select the Insert Column option on 
the Edit menu as shown below to insert a blank column named D after WEEK.  
 



 
 
Keep the column D highlighted, type the formula (C1)–2.5 in the string field of the top-left 
corner and click on the Apply button to produce the following screen.  
 

 
 
Rename the newly created variable to WEEKC by first highlighting the column, then selecting 
the Column Properties option on the Edit menu as shown below. 
  



 

 

Input the desired variable name, e.g. WEEKC, in the Header string field as shown below and 
click on the OK button. By default, all variables are assumed to be continuous. 
 

 

 
Save the changes to reisby.ss3 by selecting the Save option on the File menu. 
 

3.1.3.2 The model 

The revised random intercept-and-slope model for the response variable HDRS may be 
expressed as 

 ( ) ( )0 1 0 1HDRS WEEKC WEEKCij i i ijij ij
v v eβ β= + × + + +  

or, alternatively, as 

 ( ) ( )0 1 0 1HDRS WEEK WEEK WEEK WEEKij i i ijij ij
v v eβ β    = + × − + + − +     

where WEEK 2.5.=  
 



3.1.3.3 Setting up the analysis 

Open the previous model setup for reisby1.mum. Save the file as reisby2.mum by using the 
Save As option on the File menu. Change the title on the Configuration tab if desired.  
 
Click on the Variables tab and select WEEKC both as Explanatory Variable and L-2 Random 
Effects instead of WEEK as shown below.  
 

 
 
Save the changes to the file reisby2.mum. Select the Run option on the Analysis menu to 
produce the output file reisby2.out. Use the Analysis, View Output option to open the output 
file. 

3.1.3.4 Discussion of results 

The output file contains the final estimates of the fixed and random coefficients included in 
the model, along with some goodness of fit measures as given below. Note that the use of 
grand mean centering of the time variable has no effect on the fit statistics.  
 



 
 

3.1.3.5 Interpreting the results 

Comparison of models  

Table 3.3: Estimates and standard errors for two models 
 

Coefficient Level-2 model 
 WEEK = 0 ~ 5 WEEKC = –2.5 ~ 2.5 

0β  23.57695 17.63428 
  (0.54555) (0.56031) 

 1β  –2.37707 –2.37707 
  (0.20865) (0.20865) 

 
0

2
vσ  12.6293 18.51833 

  (3.46653) (3.61203) 

 
0 1v vσ  –1.42093 3.77654 

  (1.02595) (1.05839) 

 
1

2
vσ  2.07899 2.07899 

  (0.50417) (0.50416) 

 2
eσ  12.21663 12.21663 

  (1.10697) (1.10697) 



 
 

Table 3.3 contains the estimates and standard errors of the above two analyses. The 
coefficient for WEEKC is the same as for the uncentered variable WEEK. However, the 
variance of the random intercept (

0

2
vσ ) and the covariance term 

0 1v vσ  have changed. The 
covariance between the intercept and the WEEKC slope is now significant.  

 
Table 3.3: Estimates and standard errors for two models (continued) 
 

Deviance 2219.0375 2219.0375 
 AIC  2231.0375 2231.0375 
 SBC 2244.1754 2244.1754 
 Number of free parameters       6 6 

 
As shown above, the estimates of the slope and its variance are the same. This is because the 
scale of WEEK was not changed; only its location changed. The estimated intercept decreased 
from 23.58 to 17.63, which corresponds to the average HDRS score at week 2.5 instead of 
week 0. Similarly, the 

0

2
vσ  of intercept increased to 18.52, which shows the increase of the 

individual variance at week 2.5. The change of 
0 1v vσ  is interesting: not only the value 

changed, but also the sign. The covariance of the first analysis tells us that the higher the 
variance of intercept, the lower the variance of slope. Or say, at week 1, the HDRS score 
decreases at a faster rate for those patients who started with higher HDRS. However, at week 
2.5, the patients with higher HDRS tend to improve less.  
 

   
Figure 3.8: Changes in covariance over time 

 
When looking at the three HDRS versus WEEK plots for patient 604, 302 and 361, we can see 
why this could happen. The graphs show the change of 

0 1v vσ  from week 0 to week 2.5. 

 



3.1.4 A random intercept-and-slope with a covariate and an interaction term 

The type of depression a patient was diagnosed with was recorded as part of the study and 
information on this patient characteristic is represented by the variable ENDOG, which 
assumes a value of 1 for patients with endogeneous depression and 0 otherwise. Including 
this variable in the model allows us to explore the potential relationship between a patient's 
HDRS score and the type of depression the patient was diagnosed with. Moreover, it is 
possible that the trend in HDRS scores over the study period may differ for the two ENDOG 
groups. Including an interaction term between the time of measurement and the type of 
depression in the model will allow us to evaluate this potential relationship as well. 
 

3.1.4.1 The model 

We now include ENDOG and WxENDOG in the level-1 model. ENDOG is a dummy variable 
representing the type of depression a patient was diagnosed with, and WxENDOG represents 
the interaction between WEEK and ENDOG. The model shows changes at both levels: at level 
2, the covariate ENDOG is now included, while at level 1 the interaction between WEEK and 
ENDOG, which can potentially change from week to week, is added. The revised model for 
the response variable HDRS may be expressed as  
 
Level-1 model:  

( ) ( )0 1 2HDRS WEEK WxENDOGij i i i ijij ij
b b b e= + × + × +  

Level-2 model:  

( )0 0 3 0

1 1 1

2 2

ENDOGi ii

i i

i

b v

b v
b

β β

β
β

= + × +

= +
=

 

or, in mixed model formulation, as 

( ) ( ) ( )
( )

0 1 2 3

0 1

HDRS WEEK WxENDOG ENDOG

WEEK
ij ij ij i

i i ijij
v v e

β β β β= + × + × + ×

+ + × +
 

where 0β  denotes the average HDRS level at week 0 for the non-endogenous depression 
patients (ENDOG=0), 1β  refers to the weekly improvement for the non-endogenous group, 

2β  indicates the expected change in HDRS score for a unit change in the value of the 
interaction term WxENDOG, and 3β  refers to the average expected change in HDRS level for 
endogenous patients. 0iv  is the individual deviation from the average intercept. 1iv  denotes 
the average deviation from the slope, or say, average improvement of the HDRS.  
 



We can also write the model in terms of our original variables (WEEK and ENDOG) as: 
 
Level-1 model:  

( ) ( )0 1 2HDRS WEEK WxENDOGij i i i ijij ij
b b b e= + × + × +  

Level-2 model:  

( )
( )

0 0 2 0

1 1 4 1

ENDOG

ENDOG
i ii

i ii

b v

b v

β β

β β

= + × +

= + × +
 

 

3.1.4.2 Setting up the analysis 

To create the model specifications for this model, we start by opening reisby.ss3 in a 
SuperMix spreadsheet window. Then we use the Open Existing Model Setup option on the File 
menu to load the Model Setup window for reisby1.mum. Save the file as reisby3.mum by 
using the Save As option on the File menu. Change the string in the Title 1 text box on the 
Configuration screen to reflect the new model, thereby producing the following dialog box.  
 

 
 
Next, click on the Variables tab to proceed to the Variables screen of the Model Setup 
window. 
 



 
 
The two covariates are specified by checking the E check boxes for ENDOG and WxENDOG 
respectively in the Available grid respectively to produce the following Variables tab.  
 
Save the changes to the file reisby3.mum. To fit the revised model to the data, select the Run 
option on the Analysis menu to produce the output file reisby3.out.  
 

3.1.4.3 Interpreting the results 

Fixed effects results 

A portion of the output file reisby3.out is shown below.  
 
The interaction WxENDOG between the time variable WEEK and the depression classification 
variable ENDOG, is not significant. Given this, we can take a closer look at the estimated 
coefficients for the main effects WEEK and ENDOG respectively. Note, however, that the p-
value for the ENDOG coefficient is larger than 0.05, and thus can only be considered 
significant at a 10% level of significance. The effect of time, on the other hand, is found to be 
highly significant. While the average HDRS score is predicted to decrease by –2.37 score 
scale units each week, patients classified as having endogenous depression (i.e., ENDOG = 1) 
are predicted to have a HDRS score of 2 units higher at all occasions. 
 

 



 
 
To obtain the predicted average HDRS scores, the estimates obtained from the output are 
used: 

 0 1 2 3(WEEK) (ENDOG) (WxENDOG)
22.47626 2.36569(WEEK) 1.98802(ENDOG) 0.02706(WxENDOG)

y β β β β
∧ ∧ ∧ ∧ ∧

= + + +
= − + −

  

 

Model comparison 

A question that arises from inspection of the results obtained thus far is whether the 
interaction term contributes overall to the explanation of the variation in the HDRS scores. To 
test this, we can fit a model without the interaction term and use the deviance reported in the 
output to compare results for the model with interaction and the model without this term. The 
relevant output from an analysis without the interaction term is shown below. We note that 
the deviance obtained for the simpler model is almost identical to that of the model 
considered in this section. Based on this, we conclude that a model without the interaction 
WxENDOG would fit the data as well as the one with the interaction term included. 
 



 
  
In addition, we can test the hypothesis that the model with covariate (ENDOG) fits the data 
better than the random intercept and slope model considered previously. To test this 
hypothesis, we calculate the difference between the –2 log likelihood value obtained for the 
previous model and the –2 log likelihood value for the current model. It can be shown that 
this difference of 2219.04 – 2214.93 = 4.11 has a 2χ  distribution with associated degrees of 
freedom equal to the difference in the number of parameters estimated in the two examples, 
i.e., 8 – 7 = 1 degrees of freedom. Since the p-value for this test statistic is less than 0.05, it is 
concluded that the random intercept-and-slope model with ENDOG as a covariate provides a 
better description of the data than the original random intercept-and-slope model. This 
finding is supported by the fact that the p-value for ENDOG when the interaction effect 
between WEEK and ENDOG is excluded equals 0.04. 
 

3.1.5 A random intercept-and-slope quadratic model 

3.1.5.1 The model 

In this section we include an additional predictor and a random term to examine a possible 
quadratic response trend in HDRS scores over time. Keeping the level-2 model the same as 
before, the corresponding model for the response variable HDRS may be expressed as  
 
Level-1 model: 

( ) ( )2
0 1 2HDRS WEEK WEEKij i i i ijij ij

b b b e= + × + × +  

Level-2 model:  

0 0 0

1 1 1

2 2 2

i i

i i

i i

b v
b v
b v

β
β
β

= +
= +
= +

 

 



3.1.5.2 Preparing the data 

Create a new blank variable named WEEKSQ as shown in section 2.5.1. Highlight the column 
WEEKSQ, type the formula SQUARE(C1) where C = WEEK in the string field and click on the 
Apply button to produce the following screen. Save the change to reisby.ss3. 
 

 
 

3.1.5.3 Setting up the analysis 

Again, we can modify the model setup file of reisby1.mum by first opening it, then saving the 
file as reisby4.mum. Change the title on the Configuration tab and request Bayes estimates by 
selecting the means & (co)variances option from the Write Bayes Estimates drop-down list. 
 
Next, click on the Variables tab to proceed to the Variables screen of the Model Setup 
window. The two covariates are specified by checking the E and 2 check boxes for WEEKSQ 
in the Available grid to produce the Variables screen shown below. 
 
 

 



 
 
Save the changes to the file reisby4.mum and run the model.  
 

3.1.5.4 Interpreting the results 

A portion of the output file reisby4.out is shown below.  
 

Fixed effects results 

The level-1 estimate of the WEEKSQ coefficient is 0.05, which turns out not to be significant 
(p = 0.56). On the other hand, the WEEKSQ random effect is significant at a 5% level (p = 
0.04). Comparing the present results with those reported in reisby1.out, we see that the 
deviance difference of 2219.04 – 2207.65 = 11.19 with 10 – 7 = 3 degrees of freedom, 
indicating an improved overall model fit at a 5% significance level. These results imply that, 
although the mean trend of HDRS scores over time is linear, some of the individuals' 
trajectories are quadratic. 

 



 
 

3.1.5.5 Residuals 

Level 2 Bayes results 

Up to this point, we have considered results averaged over all patients. We now turn our 
attention to the residual file reisby4.ba2, which offers the opportunity to take a closer look at 
the results by individual patient. After running the above model, select the Analysis, View L-2 
Bayes Results option to open the image below. The contents of this file are displayed for the 
first 5 patients. Three lines of information are given for each patient, containing, in order of 
appearance, 

 
o the number of the patient in the data set,  
o the number of the empirical Bayes coefficient,  
o the empirical Bayes estimate,  
o the estimated variance of the Bayes coefficient, and  
o the name of the associated coefficient as used in the model.  

 



 
 
To obtain patient-specific predicted HDRS scores, the empirical Bayes estimate for each 
patient have to be taken into account, as these estimates indicate the extent to which the 
random intercept or slope for that patient deviates from the intercept and slope over all 
patients. Patient-specific predicted HDRS scores are calculated as 
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For the first patient shown in the residual file above, we have 0iv
∧

 = 1.4054, 1iv
∧

 = 2.6506−  

and 2iv
∧

 = 0.099315. From this information, we can already tell that the intercept for the 
patient is higher than average, but that the WEEK slope for this patient is lower than average. 
The positive value of the quadratic term indicates that the decreasing rate slows down more 
quickly than average with an increase in time. The predicted HDRS score for this patient 
(PATIENT = 101) is found to be 
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Substituting the WEEK with values 0, 1, …, 5, we get the predicted HDRS scores for Patient 
101, and similarly, for all the other patients. Table 3.4 and the graphical display below give 
the predicted HDRS for the first 5 patients. 
 



 
Table 3.4: Predicted HDRS values for selected patients 

 

 Patient 101 Patient 103 Patient 104 Patient 105 Patient 106 Population 
Avg. 

Week 0 25.166 27.507 25.998 21.011 23.643 23.760 
Week 1 20.033 24.192 22.727 18.224 22.757 21.179 
Week 2 15.202 21.117 19.102 15.765 21.587 18.701 
Week 3 10.673 18.282 15.124 13.636 20.133 16.326 
Week 4 6.446 15.686 10.792 11.836 18.396 14.054 
Week 5 2.520 13.330 6.106 10.365 16.375 11.884 

 
We find that Patient 101 had a higher initial HDRS score, but over time obtained a lower than 
average score. For Patient 103, a higher than average predicted HDRS score is obtained at 
each time point. In contrast, Patient 105 scored lower at each time point. The quadratic term 
doesn't affect much of the population average; however the effect is obvious for Patients 105 
and 106. 
 

 
Figure 3.9: Predicted HDRS for selected patients 

 

Model-based graphs 

Residual plot 
Level-1 residuals can also be obtained, either for a typical or specific patient, by using the 
empirical Bayes estimates. The residuals for a typical patient are obtained as  
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The residuals for a specific patient use the additional information given by the empirical 
Bayes residuals and have the form 
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Select the Residuals option on the File, Model-based Graphs menu to activate the Plot of 
Residuals dialog box. Check the Mark check box for WEEK as shown below, then click on the 
Plot button.  
 

 
 
The graph obtained, as shown below, shows that, in general, the range of the level-1 residuals 
is 5 5−( ; ) .  



 
Figure 3.10: Plot of level-1 residuals vs. predicted values 

 
Inspection of these residuals can be useful in examining the distributional assumptions for 
the level-1 data, in this case at the measurement level. For the current example, residuals for 
a typical patient have a mean of 0.000 with standard error of 2.66. Double-click on the 
middle of the graph to open an additional window that shows the detailed residual data for 
each observation. 
 
We note that the estimate for Patient 101 at the beginning of the study was 25.166, and 2.520 
at the end of the study. On both occasions, the residuals associated with these estimates were 
positive, indicating that the estimates are above estimated average. 
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